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Leveraging the Morningstar Notebooks

In the current market environment, access to vast amounts of data, and the capability Overview
to analyze that data to produce actionable insights is a distinguishing factor of success

in the financial services industry. Morningstar observes this in the use cases and

behaviors of clients.

Notebooks offer clients an easy and efficient way to analyze data and develop
meaningful insights. For example, a notebook can be used to quickly map the full
history of a portfolio manager's career or conduct equity ownership analysis tailored to
a specific need with a click of a button; something that would otherwise require
repeated exports and secondary analysis of data today.

< Note: To view the Analytics Lab module in Morningstar Direct, clients need to be on version
3.20.006 (June 26th, 2021 release) or later to view the Analytics lab in Morningstar Direct.

This exercise shows clients how to leverage three of the Morningstar Notebooks and
interpret their data through the following exercises:

» Discovering a Portfolio Manager's Performance History (page 7)
» Reviewing a Firm’s Diversity Data (page 18)
» Discovering Stock Ownership Popularity Details (page 27)

Be sure to also read the FAQ document for notebooks.

The first notebooks available are pre-packaged analysis as well as notebooks What Notebooks
encapsulating Morningstar research and methodology. Clients can access the are available?

following standard notebooks, providing best-in-class analytical data:
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https://morningstardirect.morningstar.com/clientcomm/NotebooksFAQClient.pdf

Leveraging the Morningstar Notebooks What Notebooks are available?

Was designed
This notebook... for this role type... At this firm type... To show...

Portfolio Manager » Manager Researcher » Wealth Manager | A holistic picture of a portfolio

» Marketing » Asset Manager manager's career — what funds
they've managed over time and how
those funds have performed during
his/her tenure compared to peers.
This allows Manager Researchers to
evaluate the comfort level with a new
manager when a change takes place
at a fund, or the Marketing team at
an asset manager to promote the
tenure and success of their team.

Performance History

Today, clients can find Manager
Tenure and Performance data in
Morningstar Direct, but view only
one piece of information at a time.
This notebook offers an intersection
of these two data points, making the
analysis simple.

Time Series Factor » Portfolio Manager » Wealth Manager | This notebook isa multiple regression
» Marketing » Asset Manager tool decomposing returns into factor
exposures, using the Fama-French
model, to derive an investment’s
Alpha and Beta exposures through
time. Multiple investments can be
selected at once for comparison, and
the time period, too.

Regression Analysis
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Leveraging the Morningstar Notebooks What Notebooks are available?

Stock Ownership Analysis » Portfolio Manager » Wealth Manager | Which funds own certain stocks of
» Compliance, Portfolio » Asset Manager interest, to manage exposure to
Manager them. Clients can also see which

funds have recently sold into or out of
a security. This makes it easy to
complete the following tasks for up to
10 stocks at a time:

» find banned securities (when a
firm needs to divest)

» evaluate exposure to “sin” stocks,
and

» track ownership of interesting or
topical stocks (such as
crypto-currencies or GameStop).

Outside of this notebook, the
ownership analysis toals in
Marningstar Direct bring clients close
to this same analysis, but they face
the limitation of the universe of
investment type owners being
searched cannot be limited, which
means clients must export data to
Microsoft® Excel® and then use
V-Lookup to see if the funds in
question are impacted.

Firm Diversity Data » Manager Researcher » Wealth Manager | Afirm's diversity from the ownership,
» Marketer » Asset Manager board and employee level. This data
gives clients insight into a firm's
diversity. Currently, clients can view
gender diversity data in Workspace
but this notebook also provides
insight into race and

disability diversity.
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Discovering a Portfolio Manager's Performance History Overview

Discovering a Portfolio Manager's Performance History

The Portfolio Manager Performance History notebook provides a holistic picture of a Overview
portfolio manager's career —what funds they've managed, and how those funds

performed during their tenure compared to peers. This allows Manager Researchers to

evaluate the comfort level with a new manager when a change takes place at a fund,

or the Marketing team at an asset manager can use the data to promote the tenure

and success of their team.

While manager tenure and performance data (as well as other statistics) can be found
in Morningstar Direct outside of this notebook, clients may encounter the following
obstacles when conducting this research:

1. This notebook by design offers an intersection of tenure, performance, and asset flow
data. Outside of the notebook, however, this information must be manually collated

2. The notebook contains a unique data point showing a manager’s career Excess Return
category percentile value. Calculating this outside of a notebook would be a
labor-intensive project.

3. An advanced search can show only funds where someone is presently a manager.
Historic assignments cannot be found via a search.

This section shows clients how to investigate a portfolio manager's history by creating
an advanced search and viewing manager tenure, performance data, and asset flows
through the new notebook. The following exercises are covered here:

» Exercise 1: Find portfolio manager history in the Workspace module on page 8

» Exercise 2: Review a portfolio manager’s history in the Portfolio Manager
Performance History notebook on page 11, and

» Exercise 3: Review a different manager in the notebook on page 16.
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Discovering a Portfolio Manager’s Performance History Exercise 1: Find portfolio manager history in the Workspace module

When a new manager is announced for a fund, or if you are considering adding a Exercise 1: Find portfolio

manager to your product shelf, understanding that manager’s performance history is a manager history in

critical part of a firm's due diligence. This exercise shows clients how to find a manager the Workspace module

via an advanced search and what other data can easily be found in the grid view. Keep
in mind that a search will find only those funds where someone is presently a manager.
Past funds where someone was a manager will not appear in the search results.

Do the following:
1. Log in to Morningstar Direct.
2. Select the Workspace module, then select Search Criteria > My Search Criteria.

3. From the toolbar, click New > Advanced Search > Funds (Open End and Exchange
Traded Funds). The Search Criteria window opens.

Be sure to search for both open end funds
and exchange-traded funds for this exercise.

Morningstar Direct
File Mew Favorites Tools Help Search for In This View - Go
Home L
[ ———
Equity/Credit Research Action = m ﬂ Export~ | [&] PDF @ Refrash
Local Databases r N Basic Search 3 Typs Ovmar Parmi
Global Databases | Advanced Search » All Managed Investments
Performance Reporting 1 =% US Stable Value Funds Analysis/News/Report Read
Bonds
Asset Allocation R Ehss Read/
ETET— ” [T Concentrated Funds Category Average Read/|
ortfolio Managemen
g [ a ESG Portfolio Class Closed-End Fund Read/|
Portfolio Analysis [O5 Fixed Income Funds College Savings Plans Read/|
Markets e Low Carbon Sustainable Fundd Ecenomic Series Read/|
PP T TR [z Low CarbonSus Exchange Traded Fund Read/|
i European Pension/Life Fund Wrappers
Presentation Studio {ZRE tanager histony: = i Read/
Mo Medalist Large Cap Funds Funds (Open End and Exchange Traded Funds) Read/|
Advanced Analysis x
[T 10 Models Strategies Read/
Workspace [t N HFR. Hedge Funds Read/|
~E& Investment Lists [ 12 Small Value Funds e\iestment Hedge Funds Read/|
E My Lists [T 13 Small-Mid Cap Performance R Market Index Read/|
& Search Criteria [T 14  Small-Mid Cap Performance R Money Market Fund Read/|
& My Search Criteria [T 15  Stocks Screen Open-End Fund Read/|
i E Repoitilemplates Ownership-Portfolio
& Chart Templates Ownership-Security
* &5 Data Sets . ;
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Discovering a Portfolio Manager’s Performance History Exercise 1: Find portfolio manager history in the Workspace module

4. In the first row, click the Field Name cell, then select Manager Name. The Select
Manager Name dialog box opens.

5. Inthe search field, enter Alex Duffy, then click Go.

6. From the Available Records area, select Alex Duffy.

Select Manager Mame *
Within |Manager MName w
Find By Name ~| (@ Begins with () Contains

|a|E>c duffy | Go

Available Records

Total records: 1

Jump to record name: | alex duffy
lex Duffy -
The manager's name must be
selected before OK can be clicked.
Help oK Cancel

7. Click OK to close the Select Manager Name dialog box.
8. Click OK to close the Advanced Search window. The funds display in the grid.

Morningstar Direct August 2021 9
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Discovering a Portfolio Manager’s Performance History Exercise 1: Find portfolio manager history in the Workspace module

9. Take note of the funds appearing here, then scroll right in the Snapshot view to see the

Manager History column.

10. Click the Multiple link under the Manager History column in any row to see when Alex

joined the fund as a manager.

Click this link in any row to see when Alex joined a fund.

Ele New Favorites Iools Help @ Search for In This View - Go
Home | My Search Criteria
Equity/Credit Research : Action~ View Snapshot - Save (ggSave As "y Search [F: Edft Data | 2 sort Locate | 4} Export= PDF
o] u
B r Hams + Managsr Nsme =nagar History Manzgar Ovmership Leval Managar
Tenure
Global Databases (Longsst]
Performance Reporting | [ 1 Bridge Builder International Equity Multiple Multiple] Multiple 3
— [T 2 Harbor Diversified Intl All Cp Admin Multiple Muttiple] Multiple 5
o "3 Harbor Diversified Intl All Cp Instl Multiple Muttiple] it
Portfolio Management o i _
2 ra Harbor Diversified Intl All Cp Inv Multiple Multiple Morningstar Direct o %
Portfolic Analysis s Harbor Diversified Intl All Cp Retire Multiple Multiple D —
Markets "6  Harbor Emerging Markets Equity Admin Alex Duffy Muttiple]
7 Harbor Emerging Markets Equity Instl Alex Du Multiple] | M Hist:
Asset Flows r ging quity ffy anager History [2021-01-04 — ] Justin Hl
— [T 8 Harbor Emerging Markets Equity Investor Alex Duffy Multiple] [2016-05-22 -- ] Simon Semerville
; o "3 Harbor Emerging Markets Equity Retire Alex Duffy Muttiple] [2018-05-01 — 2019-02-12] Simon Todd
Advanced Analysis - : ; 11-02
L& [T 10 Harbor International Administrative Multiple Multiple Egi: H gi ”"’""‘i"“;' :"Eh
-11-02 — ] Neil M. Ostrer
Workspace [T 11 Harbor International Institutional Multiple Multiple [2015-11-02 -- ] Nick Longhurst
~&5 Investment Lists [" 12 Harbor International Investor Multiple Multiple [2015-11-02 ] Charles Carter
B My Lists [T 13 Harbor International Retirement Multiple Multiple [2015-11-02 -- 2021-06-21] Michael Godfrey
B N
~E&2 Search Criteria
E My Search Criteria Robert Ansiay
+ E2 Report Templates [2015-11-02 -- 2021-06-21] David Cull
= Chart Templates [2018-05-01 -- 2013-10-04] William MacLeod
¥ £ Data Sets
+ &= Custom Database
= saved Reports
E Note Manager OK Cancel
S Retirement Plans
¥ &2 Group Manager
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Exercise Z2: Review a portfolio manager's history in the Portfolio Manager
Discovering a Portfolio Manager’s Performance History Performance History notebook

This exercise shows clients how to leverage the Portfolio Manager History notebook to Exercise 2: Review a

investigate Alex Duffy. Before using this notebook, it is important for clients to portfolio manager’s
understand the following rules: history in the Portfolio
Manager Performance

1. Only one manager can be searched for at a time. Before searching for a different

manager, the previous name needs to be removed. History notebook
2. Here, a manager’s Excess Return category percentile value is calculated. This unique
data point requires at least 12 months’ worth of data to calculate it. Therefore, any fund
where a manager has been in place for less than 12 months will not appear.
3. Related, for any fund(s) where a manager was tenured less than 12 months, that fund
will not appear in this notebook.
To use this notebook, do the following:
1. Click the Analytics Lab module.
2. From the Notebook window, click Portfolio Manager Performance History. The
notebook opens.
Select this notebook to open it.
Morningstar Direct
: File MNew Favorites Tools Help : Search for In Securities ~ Go
Home
Equity/Credit Research
Local Databases
Global Databases Latest from Mornirjgstar
Performance Reporting
Asset Allocation MANAGER RESEARCH MANAGER RESEARCH
Portfolio Management Time Series Factor Regression Portfolio Manage
Portfolio Analysis Analvsis Histow
Markets
A multiple regression tool that dpcomposes returns Review a holistic picture g
Asset Flows
into factor exposures to derive a investment’s career —the funds manag
Presentation Studio : .
alpha and beta exposures. those funds performed co

Advanced Analysis the manager's tenure.

Workspace

Analytics Lab

B Motebooks

All Notebooks

MName Topic
Time Series Factor Regression|Analysis 72 Read Only Manager Research

A multiple regression tool that decoyiposes returns inte factor exposures to derive an investment's
alpha and beta exposures.

Portfolio Manager Performance History | 2 Read Only Manager Research

FReview a holistic picture of a portfolio manager’s career—the funds managed over time and how those
funds performed compared with peers during the manager's tenure.

Firm Diversity Data Report 2 Read Only Diversity, Equity, Inclu

Understand a firm's diversity profile as a potential consideration for your manager evaluation criteria

Stock Ownership Analysis 2 Fead Only Manager Research

Discaver who owns the stocks you're interested in.

Morningstar Direct August 2021 1
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Exercise 2: Review a portfolio manager’s history in the Portfolio Manager

Discovering a Portfolio Manager’s Performance History

Performance History notebook

3. When searching for a manager here, note that the format is Last Name, First Name. The
search function also uses a "begins with” approach, and not a “contains” approach, so
be sure to know the correct spelling of the manager's last name. In the Select a
Manager field, type Duffy.

4. From the menu that opens, click Duffy, Alex (Fidelity) to select this manager.

[ Notebooks

MANAGER RESEARCH

Portfolio Manager Performance History

Review a holistic picture of a portfolio manager's career—the funds managed over time and how those
funds performed compared with peers during the manager's tenure

Maciej Kowara
Aug 10,2021

Morningstar has a record of all the funds (open-end and exchange-traded, though the latter are less relevant here) each manager managed
during his or her career, together with the manager start and end dates. We can thus calculate the performance of every fund the manager
has managed compared with peers during the manager's career. Select a manager to start your analysis.

Enter a manager's
name to investigate
their Performance History.

Select a Manager

Q duffy, alex X

1 Result

Duffy, Alex (Fidelity)

5. Next, set the Return Type to Net.
6. Click Run.

Notebooks

\ Maciej Kowara
" Aug 10, 2021

Morningstar has a record of all the funds {open-end and exchange-traded, though the
latter are less relevant here) each manager managed during his or her carger, together
with the manager start and end dates. We can thus calculate the performance of every
fund the manager has managed compared with peers during the manager's career. Select
a manager to start your analysis.

Select a Manager

Q Search for a Manager

Duffy, Alex (Fidelity)

Select a Return Type

Net v

Click Run to populate data.

Morningstar Direct August 2021
MmHNlNGSTAH © 2021 Morningstar. All Rights Reserved.

12



Exercise 2: Review a portfolio manager’s history in the Portfolio Manager
Discovering a Portfolio Manager’s Performance History Performance History notebook

The notebook is now compiling the data; this can take a minute or two to complete.
The first item to appear is the Average Percentile Return Category Rank.

Average Percentile Return Category Rank

9th Percentile

We've calculated percentile category return ranks for each fund's performance during the time of this manager’s tenure. You can see the
full details of those ranks in the Historical Perfarmance Details section below. Then, a tenure-length weighted average is done on thase
percentile ranks to give an overall picture of how the manager has performed compared to peers during their career.

The tenure-length weighted average of this manager is the 9th percentile.

This is computed by first calculating the percentile category return ranks for each
fund's performance during the time of this manager's tenure. Then, a tenure-length
weighted average is done on those percentile ranks to give an overall picture of how
the manager has performed compared to peers during their career. This data is only
available in the Portfolio Manager Performance History notebook.

The next section displays the Excess Return Over Category Benchmark chart. This chart
displays all funds the manager has managed over time, alongside the fund's excess
return versus the MPT Index, which is the benchmark assigned to investments based
on their Morningstar category. This Excess Return is calculated in the base currency of
the fund.

Excess Return Over Category Benchmark

The chart below displays all funds the manager has managed over time, alongside the fund’s excess return versus the Morningstar category
index.

M Excess Return (Base Currency)
0.00 428 8.57

Fideiy Global Emerging Markets (013172014 - 0573012021 [
Fidelty Global Emerging Markets ETF (1173072018 - 067302021 [
Omnis Global Em MKkts Eq Ldrs A Inc (09/30/2019 - 06/30/2021) _
Fidelty Emerging Mits Foc -Ace-USD (103172014 04302021 [

Fidelity Latin America A-Dis-USD (05/31/2009 - 03/31/2015) - I
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Exercise Z2: Review a portfolio manager's history in the Portfolio Manager
Discovering a Portfolio Manager’s Performance History Performance History notebook

The Historical Performance Details table provide the full historical performance details
over the full period of the manager's tenure on the fund. In addition to Excess Return,
the category percentile rank is calculated for both Excess Return and Sharpe Ratio.

The Morningstar Category Index (also known as MPT Index for non-US markets) is used
to calculate the Excess Return and the MPT Risk-Free Rate is used to calculate the
Sharpe Ratio.

Percentile

Percentile Sharpe Ratio

Return Rankin  Rankin Number of Morningstar Excess Return

Category Category Funds in Category Over Category
Fund Name Fund of Funds ~ Base Currency  During Tenure  During Tenure  Category Index Benchmark
Fidelity Global No AUD 1 1 27 MSCIEMNR 3.6
Emerging AUD
Markets
Fidelity No usD 2 6 455 MSCIEMNR 479
Emerging Mkts usD
Foc I-Acc-USD
Fidelity Latin No usD 21 50 65 MSCI EM 1.66
America A-Dis- Latin America
Uso NR USD
Fidelity Global No AUD 3 5 46 MSCIEM NR ~ 8.16
Emerging AUD
Markets ETF
Omnis Globa No GBP 16 23 617 MSCIEM NR  3.49
Em Mkts Eq usb
Ldrs A Inc

Based on the table above, we notice that Fidelity Global Emerging Markets, which
ranked in the 1st percentile rank in category during the manager tenure and exceeded
the category benchmark by 3.46%.

Morningstar Direct August 2021 14
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Discovering a Portfolio Manager’s Performance History

Exercise 2: Review a portfolio manager’s history in the Portfolio Manager

Performance History notebook

To further investigate this fund, do the following:

1.

2.

Using the Select a Fund drop-down menu, select Fidelity Global Emerging Markets.

Select a Fund

Fidelity Global Emerging Markets Vv

Fidelity Emerging Markets Focus Fund
Fidelity Latin America Fund
Fidelity Global Emerging Markets ETF

Omnis Global Em Mkts Eq Ldrs Fd

Run

Click Run. The Cumulative Growth During Manager Tenure chart appears on screen,

illustrating how the fund performed against MSCI EM NR AUD since the start of the
manager tenure in early 2013.

Cumulative Growth During Manager Tenure

25,000 Fidelity Global

MSCI EM NR
AUD

21,000

17,000

13,000

Return {AUD}

9,000

Emerging Markets

2013 2015 2016 2017 2018 2019 2020 2021

Select this fund from the list.

MORNINGSTAR
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Discovering a Portfolio Manager’s Performance History Exercise 3: Review a different manager in the notebook

Lastly, the notebook reports the Assets Under Management During Manager Tenure
increased, despite a difficult 2020. This section offers a unique view into the
juxtaposition between performance and asset growth.

Assets Under Management During Manager Tenure

700,000,000

525,000,000

350,000,000
g 175,000,000
FH
s 0

2014 2015 2016 2017 2018 2019 2020 2021

To view a different manager's performance history, do the following: Exercise 3: Review a

1. From the Select a Manager section, hover the cursor over Duffy, Alex then click the Eilfferent Manager
Remove icon. in the notebook

MAMNAGER RESEARCH

Portfolio Manager Perfor

Review a holistic picture of a portfolio manage
with peers during the manager’s tenure.

Maciej Kowara
Aug 17, 2021

Morningstar has a record of all the funds {open-end and excha
the manager start and end dates We can thus calculate the pe
manager to start your analysis.
Select a Manager

Q Search for a Manager

Duffy, Alex (Fidelity) o
e ! Hover the cursor over a

manager's name to see this icon.
Select a Return Type

Net v

Morningstar Direct August 2021 16
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Discovering a Portfolio Manager’s Performance History Exercise 3: Review a different manager in the notebook

2. Using the Select a Manager field, type Agranoff, Felise.

3. From the menu, click Agranoff, Felise (JPMorgan) to select this manager.

Note the opti lected.
Select a Mﬂﬂﬂgﬂl’ ote the options selecte

Q Agranoff, Felise X

1 Result

Agranoff, Felise (JPMorgan)

Select a Return Type

Net v

Run

4. Click Run.

Morningstar Direct August 2021 17
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Reviewing a Firm's Diversity Data

Overview

Reviewing a Firm's Diversity Data

The data elements within the Firm Diversity Data Report notebook are surveyed
responses from asset management firrms; they are not collected from public filings. In
contrast, the Gender Diversity data available within the preset views elsewhere in
Morningstar Direct are collected from the filings of public companies and then rolled
up to the fund level. Also, note that this notebook has its own dedicated FAQ.

This section covers the following exercises to help clients understand where to find this
data and understand how to use the Firm Diversity Notebook:

» Exercise 4: Analyze diversity data in preset views on page 18, and
» Exercise 5: Research various firms in the Firm Diversity Data Report notebook on
page 20.

To investigate company- or fund-level gender diversity data, do the following:
1. Select the Workspace module, then select the My Lists page.
2. Double-click the Sustainable Landscape U.S. Funds Q2 2021 list to open it.

Overview

Exercise 4: Analyze
diversity data in
preset views

File MNew Favorites Tools Help In This View - Go

Home

Search for

Equity/ Credit Research
Local Databases r
Global Databases

Performance Reporting it

Asset Allocation rz
03
Portfolio Management 4
Portfolio Analysis s
Markets [
Asset Flows |
Presentation Studio rs
o
Advanced Analysis
[ 10
Workspace i
& Investment Lists [ 12
B My Lists [Eias
v &5 Search Criteria r 1a

Action * | fd New ﬂ Export~ | [&] PDF @ Refresh

Name

Morningstar Open Index Project

Double-click the name
of this list to open it.
Maorningstar

| Sustainable Landscape U.5. Funds Q2 2021

Sustainable Landscape Global Funds Q2 2021
Sustainable Landscape European Funds Q2 2021
Morningstar Prospects

2020 Bond Funds

American Century Five-Globe Funds
Blockchain

Boston ESG Funds

Calvert Funds ESG

Class

Class 3

Combined Funds

Concentrated Funds

Maorningstar
Marningstar
Maorningstar
Marningstar
Web-Based
Web-Based
Web-Based
Chelsea Beckford
Web-Based
Chelsea Beckford
Web-Based
Web-Based
Chelsea Beckford

MORNINGSTAR
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https://morningstardirect.morningstar.com/clientcomm/FirmDiversityFAQ.pdf

Reviewing a Firm's Diversity Data

Exercise 4: Analyze diversity data in preset views

3. From the View drop-down field, select Sustainability: Gender Diversity (Fund). What
data points appear here?

My Lists

i @ save ki Add [ Edit Data | 39 5ot @, Locate | i

Global
Category

Moderate Allocation

US Equity Large Cap Growt
US Municipal Fixed Income
Global Equity Large Cap
Global Equity Large Cap

. Action~ [PV VY RV . Gender Diversity (Fund )l
I Name My Data Set AP
Snapshot
Sustainability: ESG Risk (Conmjpany)
z | Sustainability: ESG Risk (Fund)
C1 1918 Sacially Responsi| gy etainability: Carbon Risk (Gompany) 2021
[O2 AB FlexFee US Themati Sustainability: Carbon Risk (Fund) 2021
— Sustainability: Carbon Involvgment (Company)
- AB Impact Municipal In| systainability: Carbon Involvément (Fund) 2021
ra AB Sustainable Global 1 Sustainability: Product Invelvgment (Company) 2021
- Sustainability: Product Invelvement (Fund)
[Os AB Sustainable Intl The i Dive 2021
yi Gender Diversit —

s AB Sustainable Themat 2021
7z Aberdeen Emerging Mkts Sustldrs InstlSvc FOUSADQOAPA 7/31/2021
s Aberdeen Global Equity Impact Instl FOUSADSBYA 7/31/2021
s Aberdeen International Sust Ldrs A FOUSADOCCL 7/31/2021
[ 10 Aberdeen US Sust Ldrs Smilr Coms C FOUSADOHYS 7/31/2021
11 Aberdeen US Sustainable Leaders A FOUSADOLBE 7/31/2021
™ 12 Access Capital Community Investment I FOUSADBBSC 6/30/2021
M 13 Adasina Social Justice All Cp Glbl ETF FOOOO15LRM 8/24/2021

Holdings Analysis. The Detailed Holdings Analysis window opens.

Select this option to see

US Fixed Income

Europe Emerging Markets
Global Equity Large Cap
Global Equity Large Cap
US Equity Large Cap Growt
US Equity Large Cap Growt
US Fixed Income

Global Equity Large Cap

4. Right-click the name of any equity fund, then select View Holdings > Detailed

Select this view to
see gender diversity
data rolled up from
the underlying
holdings in a fund.

Morningstar Direct

Eile New

Home

Equity/Credit Research
Local Databases
Global Databases
Performance Reporting
Asset Allocation
Portfolic Management
Portfolio Analysis
Markets

Asset Flows
Presentation Studio
Advanced Analysis
Workspace

~E&& Investment Lists
H My Lists
~E8 Search Criteria
E My Search Criteria
» B3 Report Templates
E Chart Templates
} B8 Data Sets
» & Custom Database
E Saved Reports
B Note Manager

Favorites Tools

Help

| My Lists

Search for

Action~| &4 A~ + ¥ View Sustainability: Gender Dive - iESava K Add [ Edit Data

r

Cia
M=
rs
4
s
s
Oz
e
o
[ 10
i
12
13
14
15
16
Oaz
[ 18
19
[ 20

MName

1919 Socially Responsive Balanced A
AB Sustainable US Thematic Advisor

AB Impact Municipal Income

AB Sustainable Global Thematic A

AB Sustainable Intl Thematic A

AB Sustainable Thematic Credit Advisor
Aberdeen Emerging Mkts SustlLdrs Inst/Sy
Aberdeen Global Equity Impact Instl
Aberdeen International Sust Ldrs A

Aberdeen US Sust Ldrs Smir Coms C
Aberdeen US Sustainable Leaders A

Access Capital Community Investment I

Adasina Social Justice All Cp Glbl ETF
AGF Global Sustainable Growth Equity I

Alger Responsible Investing &

Freedom 100 Emerging Markets ETF

ALPS Clean Energy ETF

Amana Developing World Investor

Amana Growth Investor

holdings-level information for a fund.
In This View - Go
P sort @, Locate | 4} Export - | 3]
Secld Portfolio Glob3l Percent of
Data Catagory Femala
Executives
Seimesama st * derate Allocation 23.26
T e
SEIEEE Efuity Large Cap Growt 22.09
o i z
View Accounts With Holding Mhinicipal Fixed Income
Mew Transaction bl Equity Large Cap 21,84
Wiew Transactions b3l Equity Large Cap 17.61
WView Prices Fiked Income
Edit Security rope Emerging Markets 15.57
Reports » 3bgl Equity Large Cap 15.39
Interactive Charts # b3l Equity Large Cap 18.59
Risk Model & Equity Large Cap Growt 18.19
. ¢ Equity Large Cap Growt 23.55
Presentation Studio Charts >
Filked Income
Premium;/Discount B R R .
View Holdings > | Top Ten Helding An g
View Owners - I Detailed Holding Analysis 5
View Fundcode Info Histerical Holding Analysis 5
View Histerical Instruments Peer Holding Analysis 2
View Historical Regions bal Emeraing Markets E 14.75
X-Ray Equity Large Cap Growt 23.85
Performance Attribution » |Fauity Large Cap Blend 26.13

Amana Income Investor
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Reviewing a Firm's Diversity Data

Exercise 5: Research various firms in the Firm Diversity

Data Report notebook

5. From the View drop-down field, select Sustainability: Gender Diversity (Company).

What data points are offered here?

Morningstar Direct

File New Favorites Help

1919 Socially Responsive Balanced A ]

Search for

In This View

© Action~ View Portfolio g -| € 7/31/2021 [F%Edit Data | @,
r Mame My Data Set CUSIP
Snapshot
Stable Value Fund Data
g Sustainability: ESG Risk (Company) v
e Fidelity® Inv MM Fds Gover| 5ctainability: Carbon Risk (Gompany) 316175108 Sséegér;hlzr\]/'?l‘gvt;
@2 Microsoft Corp Sustainability: Carbon Involveément (Company) 594915104 q dp' y't dat
Sustainability: Product Involvgment (Company) gendendiversityldata:
s Apple Inc Sustainability: Sustainable Products (Compan 037833100
s Alphabet Inc Class A Susta|nab|l|tv: Gender Diversity (Company) 02079K305
HFF. Funds
s Amazon.com Inc BMIN USUZ31351067 023135106
e Bank of America Corp BAC US0605051046 060505104
| NVIDIA Corp NVDA UsS67066G104 67066G104

Only one firm at a time can be shown in the Firm Diversity Data Report notebook. To

investigate firm diversity data for a number of asset managers in the Firm Diversity

Data Report notebook, do the following:

1. Select the Analytics Lab module. If the previous notebook is still showing, click the
Notebooks page in the left-hand navigation pane to reset it.

2. Select the Firm Diversity Data Report. The Firm Diversity Data Report notebook opens.

3. Using the Firm Selection field, type Vanguard. Note the result shown.

Exercise 5: Research
various firms in

the Firm Diversity
Data Report notebook

DIVERSITY, EQUITY. INCLUSION

Firm Diversity Data Report

Understand a firm's diversity profile as a potential consider]
Morningstar
‘ ‘ ‘ Aug 12, 2021

A report that provides insight into the presence of diversity within an asset man
Firms available in this report are those that have submitted their data to Marning
to collect mare firm diversity data from asset managers. For more information on

found here.

Select an asset management firm below and run the report to begin analysis.

If a firm has not submitted
diversity data to Morningstar,
it will not appear in the Firm
Section drop-down field.

Firm Selection

‘;’anguaﬂ:‘ v

No Results Found

MORNINGSTAR
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Reviewing a Firm's Diversity Data

Exercise 5: Research various firms in the Firm Diversity

Data Report notebook

4. Using the Firm Selection field, type Voya, then select Voya Investment

Management LLC.
5. Click Run.

MWDBE Ownership Certification

Effective Date

2021-05-31 v

MWDBE Certified
No

Certification Source
Not Available
Ownership by Diverse Groups

Effective Date

2020-12-31 v

Percent Owned by Employees
0.00

Percent Owned by Women
0.00

A certification confirming that a company is primarily owned, managed, and/or controlled by members of a racial or ethnic minority, women
or person(s) with a disahility. The certification is often, but not always, provided by some form of external review, assessment or audit.

Diversity

Diversity

Promoting Diversity

Voya Investment Management Co. LLC (US) Board Workforce

Firm did not submit this information

Voya Investment Management Co. LLC (US) Employee Workforce

Firm did not submit this information

Voya Investment Management Co. LLC (US) Policies and Practices

MORNINGSTAR
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Reviewing a Firm's Diversity Data

Exercise 5: Research various firms in the Firm Diversity

Data Report notebook

6. Using the Firm Selection field, type T.Rowe then select T.Rowe Price.

7. Click Run.

Notebooks

Firm Diversity Data Report

Understand a firm's diversity profile as a potential
consideration for your manager evaluation criteria.

Marningstar
‘ ‘ Aug 12, 2021

A report that provides insight into the presence of diversity within an asset
management firm's ownership, board, employee workforce, company policies,
and hired service providers. Firms available in this report are those that have
submitted their data to Morningstar any time after April 15th, 2021 which was
the date Morningstar released its expanded capabilities to collect more firm
diversity data from asset managers. For more information on data collection,
coverage, and capahilities please view the Frequently Asked Ouestions
document found here.

Select an asset management firm below and run the report to begin analysis.

Firm Selection

T. Rowe Price v

Select T. Rowe Price.

MORNINGSTAR
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Exercise 5: Research various firms in the Firm Diversity

Reviewing a Firm's Diversity Data

Data Report notebook

The first section to appear is the MWDBE (Minority, Women, and Disadvantaged
Business Enterprises) Ownership Certification. The certification confirms that a
company is primarily owned, managed, and/or controlled by members of a racial or
ethnic minority, women, or person(s) with a disability. T. Rowe Price does not have a
MWDBE Ownership Certification.

MWDBE Ownership Certification

Effective Date

2021-06-30 v

MWDBE Certified
No

Certification Source
Not Available

A certification canfirming that a company is primarily owned, managed, and/or controlled by members of a racial or ethnic minority, women,
or person(s) with a disability. The certification is often, but not always, provided by some form of external review, assessment or audit.

Note the MWDBE Certified section.

The next section displays a firm's ownership by diverse groups. Employees own eight
percent of T.Rowe Price.

Ownership by Diverse Groups

Effective Date

2021-06-30 v

Percent Owned by Employees
8.00

Percent Owned by Women
Not Available

Percent Owned by Persons With a Disability
Not Available

Note the percent
owned by employees,

Morningstar Direct August 2021
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Exercise 5: Research various firms in the Firm Diversity

Reviewing a Firm's Diversity Data

Data Report notebook

The next section displays the Board Workforce Diversity. T. Rowe Price has four female
board members, one Asian board member and two Black or African American
board members.

T. Rowe Price Board Workforce Diversity

Effective Date

2020-12-31 v

Board Members by Diverse Groups

Size of Board
1

Female Board Members
4

Board Members With a Disability
0

Board Members By Race and Ethnicity

Race and Ethnicity Number of Board Members

Asian 1

s}

Black Or African American

Hispanic Or Latino 0

Morningstar Direct August 2021
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Reviewing a Firm's Diversity Data

Exercise 5: Research various firms in the Firm Diversity

Data Report notebook

The next section displays the employee diversity data by gender and race.

Employee Role or Gender

All Employees

Number Of Employees
6704

Percent Female
4476

Percent Person(s) With a Disability
0.0

Percent By Race/Ethnicity

Race and Ethnicity %
O Asian 1043
© Black Or African 11.83
American
O Hispanic Or Latino 4.00
O MNative American Or  0.12
Alaska Native
O Native Hawaiian Or  0.16
Other Pacific
Islander
O White 70.35
© Other Race 0.00
© Two Or More Races 251
© Race Mot Disclosed  0.60

MORNINGSTAR
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Exercise 5: Research various firms in the Firm Diversity
Reviewing a Firm's Diversity Data Data Report notebook

The next section displays the Policies and Practices Promoting Diversity data. T. Rowe
Price has a Firm Diversity Equity and Inclusion Policy in Place.

T. Rowe Price Policies and Practices Promoting Diversity

Effective Date

2020-12-31 v

Diversity, Equity, and Inclusion Policy

An indication of whether the firm has a formal policy autlining a company's mission, strategies, and practices to promote an organizational
culture that values diversity, supports the needs of a diverse work force, and promates the recruitment of employees impartially from a
diverse field of suitably qualified candidates.

Firm Diversity Equity and Inclusion Policy in Place
Yes

Firm Diversity Equity and Inclusion Policy Under Consideration
Not Available

The last section displays Expenditure with Diverse Vendors data. This section shows
the total number of contracts and expenditures with all service providers that are
minority, women, and person(s) with a disability-owned business. T.Rowe signed 62
contracts last year with diverse vendors.

T. Rowe Price Expenditure With Diverse Vendors

Effective Date

2020-12-31 v

Diverse Ownership Service Providers

The total number and expenditure of contracts in a one-year period with all service providers that are minority, women, and person(s) with
a disability-owned businesses. Ownership is typically, but not always, defined as at least 51% equity is owned, managed, and/or controlled
by one of such demographic groups.

Majority of Equity is Owned By Annual Number of Contracts Annual Contract Expenditure - USD
Racial Or Ethnic Minorities 20 630612207
Women 42 2042063175
Total 62 2672675382

Morningstar Direct August 2021 26
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Discovering Stock Ownership Popularity Details

Overview

Discovering Stock Ownership Popularity Details

Imagine you are reviewing a set of undervalued stocks, in consideration of adding one
or more to your portfolio. What other managers share your sentiment in seeing the
company as being undervalued and worthy of inclusion? Which of these managers
have added the stock in the past three months? In contrast, which managers have
taken the contrarian view and completely sold out of the stock in the past three
months? The Stock Ownership Analysis notebook depicts which funds own certain
stocks of interest.

Up to 10 stocks at a time can be included in this notebook to help you do the following:

» find banned securities (when a firm needs to divest)

» evaluate exposure to "sin" stocks

» track ownership of interesting or topical stocks (such as crypto-currencies or
so-called “meme” stocks, such as GameStop or AMC Theaters).

Outside of this notebook, the stock ownership analysis window in Morningstar Direct
takes you close to this analysis, but faces the following limitations:

» When looking at stock owners, investment types cannot be filtered, so the data
must be exported to Microsoft® Excel® and then use V-Lookup to see if the funds in
question are impacted

» Likewise, investment ownership data here is commingled with institutional
ownership data

» You cannot filter for new positions in the past three months, and

» You cannot see which funds have recently sold out of a position; only current
owners are shown.

The following exercises are covered here:

» Exercise 6: Find undervalued stocks on page 28

» Exercise 7: Find Stock Ownership on page 32

» Exercise 8: Leverage the Stock Ownership Analysis notebook for one stock on
page 33

» Exercise 9: Leverage the MSHOLDING Formula in Excel Add-In on page 37, and

» Exercise 10: Leverage the Stock Ownership Notebook with multiple stocks on
page 40.

Overview

Morningstar Direct August 2021
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Discovering Stock Ownership Popularity Details

Exercise 6: Find undervalued stocks

The following exercise shows clients how to find undervalued stocks through an

advanced search. This result set can serve as a starting point to find stocks to
investigate in the Stock Ownership notebook.

To find undervalued stocks, do the following:

1.

Select the Workspace module, then select Search Criteria > My Search Criteria.

2. From the toolbar, click New > Advanced Search > Stock.

Exercise 6: Find
undervalued stocks

Meorningstar Direct

MORNINGSTAR

File MNew Favorites Tools Help Search for In This View * Go
Home I
IREERS——
Equity/Credit Research Action~ _ Q Export - | & PDF | @ Refresh
Local Databases [ N Basic Search 3 Type Cwner A
Global Databases | Advanced Search » All Managed Investments
Performance Reporting O1 US Stable Value Funds Analysis/News/Report » I
ivi Bonds
Asset Allocation Oz 2021 Dividend Payers R
O3 Analyst Rated Funds and Tenu Category Average 4 R
Portfolioc Management
4 Concentrated Funds Closed-End Fund R|
Rogtfclic Aoalisis s Core and Core Plus Funds College Savings Plans 4 R
Markets | Corporate Bond ETFs Economic Series Rl
Asset Flows 7z Fixed Income Funds Exchange Traded Fund A
Eurcpean Pension/Life Fund Wrappers
Presentation Studio s French US Dollar Funds P PP R
| | Low Carben Sustainable Fundd Funds (Open End and Exchange Traded Funds) Rl
Advanced Analysis B
[T 10 MoatTrends Strategies A
Workspace M 11 Models HFR Hedge Funds R
&8 Investment Lists [T 12 Multialternative National Interr eVestment Hedge Funds R|
E My Lists [T 13 Muni Funds Market Index =
~ &8 Search Criteria [T 14  Securitized Bond Funds Money Market Fund R|
B My Search Criteria | [~ 15 Small value Funds Open-End Fund 2
' E Report Templates Ownership-Portfolio
B Chart Templates Ownership-Security
» Bl Data Sets Pension/Life/1 ,
ension/Life/Insurance
» B Custom Database _
& Saved Reports Private Fund.s
= Note Manager Global Restricted Funds
E Retirement Plans Separate Accounts
» B3 Group Manager Collective Investment Trusts Create a search
Models for this universe.
eVestment Separate Accounts
Stock
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Discovering Stock Ownership Popularity Details Exercise 6: Find undervalued stocks

3. Enter the following criteria:

Rel ( Field Name Operator | Value )
( Exchange = Nasdaq
Or Exchange = New York Stock Exchange, )
Inc.
And ( Morningstar Rating Overall | = 5
Or Morningstar Quantitative = 5 )
Rating Overall

4. Click Run Search.

Note the highlighted areas.

florningstar Direct -- Stocks - O *
@ Open Te=lInsert X Delete zZ?Clear All ﬂ Export~ [E|PDF @ (gSave As g Feedback
D Rel E Field Name Operator Value )
1 - ( Exchange = ock Exchangs, Inc. ~
2 |or Exchange =
]z |And ( Marningstar Rating Overall =
14 or Morningstar Quantitative Rating Overall =
s
16
17
ImE:
9
110
111
112
[]13 w
View Field Name: Include: Items Searched: Ttems Found:
© By Category Only Surviving Investments 134630 59
OA\phabetically D User Defined Primary Class Only
Help oK Cancal

5. Click OK to close the Search Criteria window. The next step will be to investigate exactly
how undervalued a stock is, and how this valuation and the stock’s price has changed in
the past three months.
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Discovering Stock Ownership Popularity Details

Exercise 6: Find undervalued stocks

6. Double-click the first stock in the grid view. The Morningstar Report opens in a
web browser. What is the fund's Fair Value price, and what is it currently trading at?

7. Click Show Full Chart. A pop-up window appears.

BABA Analysis Price vs. Fair Value Sustainability Trailing Returns  Fin

Alibaba Group Holding Ltd ADR BABA Yok x

Show Full Chart >

|

BGEH - 272291

Previous Close

o

12p

=

5D | New York Stock Exchange | Prices updated as of Aug 31, 2021, 12:19 PM EST | BAT

Morningstar's Analysis © @Iz Bulls §

Valuation Aug 04, 2027 Currency in USD

BABA is at a 46% Discount.

Click this link to see a more
detailed view of a stock's
price movement over time.

Fair Value

302.00

Uncertainty:High

% ko Last Close

162.29

A stock's fair value
estimate can be seen here.
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Discovering Stock Ownership Popularity Details

Exercise 6: Find undervalued stocks

8. Select the 3M option.

9. Click Fundamentals, then toggle on the option for Fair Value. How has the price and the
Fair Value Estimate changed (if at all) over this time period?

Select the correct time period, and this
option from the Fundamentals button.

_. Add Comparison

(EE Events & Ind'\catnrs) (EE

Drawings) (EE Displav)

Co s [ [ w [ o

vio | v [ 3v | sv [ 1ov | MAX ) | Fundamentals

BABA -57.19 | -26.06% Fair Value

Price/Earnings

32000 :
Price/Sales (@D)
280.00 Price/Boak @
Price/Cash (@D
240.00
Fair Value (™
200.00 Rolling Dividend @
S Dividend Yield (@D)]
: @)
120,00 Rolling EPS @)
o - % ShortInt. @
Volume
100 mil
10. Return to Morningstar Direct.
Morningstar Direct August 2021 31
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Discovering Stock Ownership Popularity Details

Exercise 7: Find Stock Ownership

The following exercise shows clients how to investigate which funds own a certain
stock. To find Stock Ownership, do the following:

1.

Right-click the first stock in the grid view, then select View Owners > Detailed

Owner Analysis. The Detailed Owners window opens.

My Search Criteria

r

r:
re
[wiE]
r4
Os
rs
o7
ra
rs
™ 10
011
12
113
[ 14
[ 15
|
017
| it
™ 19
™ 20
121
22
[ 23

¢ Action~ View Snapshot

Name

Aegon NV ADR

AerCap Holdings NV
AGNC Investment Corp
Air Lease Corp Class A

American Equity Investm:

hd Esave ‘@ save As "y’ Search [#% Edit Data @Surt \%Lucate ﬂ Export~
SEC CIK

a Ticker

BF 7RA1A

View Vehicles

View Accounts With Holding
New Transaction

View Transactions

Exchange

Mew York Stock Exchange, Inc.
Mew York Stock Exchange, Inc.

Masdag

Mew York Stock Exchange, Inc.
Mew York Stock Exchange, Inc.

Exercise 7: Find
Stock Ownership

Detailed Owner Analysis to

view a stock’s ownership.

American Finance Trust Ir ) ) Masdag

American International Gi View Prices Mew York Stock Exchange, Inc.
ArcelorMittal 54 ADR Edit Security Mew York Stock Exchange, Inc.
Associated Banc-Corp Reports > New York Stock Exchange, Inc.
Assured Guaranty Ltd Interactive Charts 5 Mew York Stock Exchange, Inc.
AthEHE.HOMIﬂQ L.td C|ESSI R Modsl 4 MNew York Stock Exchange, Inc.
Atlas Air Worldwide Holdir Masdag

Atlas Corp Presentation Studio Charts 2 Mew York Stock Exchange, Inc.
Avnet Inc Premium/Discount Nasdag

Axis Capital Holdings Ltd View Holdings New York Stock Exchange, Inc.
Banco Bilbao Vizcaya Ar View Owners > Detailed Owner Analysis

Banco Santander SA ADR
Barclays PLC ADR
Beazer Homes USA Inc
Brighthouse Financial Inc
British American Tobacco
Cango Inc ADR

Canon Inc ADR

View Fundcode Info

View Historical Instruments
View Historical Regions
X-Ray

Performance Attribution

Prrtfnlin Analvej

Peer Owner Analysis
Shareholder Information

MNasdag

New York Stock Exchange, Inc.
New York Stock Exchange, Inc.
New York Stock Exchange, Inc.

Double-click the Portfolio Weighting % column header to sort the data in
descending order. Note that values, and keep in mind that these are not merely
managed investments being shown here.

MORNINGSTAR
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Exercise 8: Leverage the Stock Ownership Analysis notebook

Discovering Stock Ownership Popularity Details

for one stock

This exercise shows clients how to use the Stock Ownership Analysis notebook for a
single stock. Do the following:

1.

Select the Analytics Lab module. If the previous notebook is still showing, click the
Notebooks page in the left-hand navigation pane to reset it.

Click the Stock Ownership Analysis notebook to open it.

In the Select Stock(s) of Interest search field, type the name or ticker symbol of the
stock from the first row of the grid view from the search results.

Select the correct stock when it appears.

Exercise 8: Leverage the
Stock Ownership
Analysis notebook

for one stock

Ele New Favorites Tools Help - Searchfor In Securities - Go

Home Notebooks

5 Send us feedback.

Equity/Credit Research

MANAGER RESEARCH

Stock Ownership Analysis

Discover who owns the stocks you're interested in

Morningstar
\ ‘ Jul 21,2021

This notebook searches Momingstar's equity ownership database to determine which open-end or exchange-traded funds hold positions in|
up to 10 selected stock(s). It also allows filtering to funds that have recently bought or sold the selected stock(s) in the last three months
Please note that if no minimum date of ownership is entered, data from one year ago to the current day will be displayed

Select Stock(s) of Interest
Q AEG X

14 Results

Aegon NV ADR

AEG « ST =« NEW YORK STOCK
EXCHANGE, INC.

Aegon NV ADR
AEG - ST + BOLSA MEXICANA DE

Start by selecting
the correct stock.
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Exercise 8: Leverage the Stock Ownership Analysis notebook
Discovering Stock Ownership Popularity Details for one stock

5. Select the following values:

From this field... Select this option...

Select Universe to View Ownership Select an investment type, region, and active/passive designation

Select an Investment Type Open-End Fund, Exchange-Traded Fund
Select a Region United States

Select Active or Passive Active

Select Exposure Type Weight %

Select Minimum Date of Ownership | Leave blank

Select Universe to View Ownership Note the options selected.

@ Select an investment type, region, and
active/passive designation

() Select a list or search criteria

Note: Only open-end and exchange-traded
funds from your list or search criteria will
return in the results.

() Select individual fund(s)

Select an Investment Type

Open-End Fund X v

Exchange-Traded Fund X

Select a Region

United States X v

Select Active or Passive

Active v

Select Exposure Type
Weight % v

Select Minimum Date of Ownership
(optional)
MM/DD/YYYY

Run

6. Click Run. The notebook is now compiling the data; this can take a minute or two
to complete.

Morningstar Direct August 2021 34
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Exercise 8: Leverage the Stock Ownership Analysis notebook
Discovering Stock Ownership Popularity Details for one stock

The report first displays the Stock Ownership table, which is a list of all open-end funds
(in this instance) investing in the stock. The table is sorted by the weightsina
descending order and includes the fund's latest portfolio date where it invested in

the stock.

The table displays only 10 funds at a time, but you do have a menu in the bottom-right
corner to Show 25, 50, 100 or All.

Stock Ownership

Fund Name Portfolio Date Aegon NV
Dodge & Cox Stock Fund 2021-06-30 0.357
Dodge & Cox Balanced Fund 2021-06-30 0.22
Avantis® International Equity ETF 2021-08-11 0.088
PMC Diversified Equity Fund 2021-03-31 0.088
Avantis® International Equity Fund 2021-06-30 0.058
DFA World ex US Targeted Val Portfolio 2021-05-31 0.053
DFA Tax-Managed International Value Port 2021-06-30 0.047
DFA International Sustainahility 1 Portf 2021-06-30 0.036
DFA Large Cap International Portfolio 2021-06-30 0.029
DFA Intl Social Cor Eq Portfalio 2021-06-30 0.021
Page 1v of3 > Viewing 110 100f 26 Show 10 w

The next section is the Recent Buys and Sells, which contains two tables:

» Managers Who've Recently Established A Position

Managers Who've Recently Established A Position

No Data Available

No funds in your selected universe have established a
position in this stock in the last three months.

In some instances, no fund may have initiated a position in the stock in the last
three months.

Morningstar Direct August 2021 35
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Exercise 8: Leverage the Stock Ownership Analysis notebook
Discovering Stock Ownership Popularity Details for one stock

» Managers Who've Recently Sold Their Position

Take note of the fund with the highest percentage in the stock as of its portfolio date of
June 2021 that sold out completely of this position.

1 = T
Managers Who've Recently Sold Their Position

Fund Name Latest Portfolio Date Aegon NV
PMC Diversified Equity Fund 2021-06-30 0.088
JHancock International Small Company Fd 2021-06-30 0.019
Strategic Advisers® International Fund 2021-06-30 0.01
Brighthouse/Dimensional Intl Sm Cm Port 2021-06-30 0.001

A stock is considered bought or sold when a position is new or liquidated from a
beginning period portfolio to the latest portfolio. The beginning period portfolio is the
portfolio reported as of three months ago or up to six months ago, whichever is the
most recent reporting date. The latest portfolio is the last portfolio reported within the
past three months. For recently bought stock(s), the weight, shares, or market value
displayed correspond to the latest portfolio date of the fund. In cases of recently sold
stock(s), the weight, shares, or market value correspond to the beginning

period portfolio.
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Discovering Stock Ownership Popularity Details

Exercise 9: Leverage the MSHOLDING Formula in Excel Add-In

A similar holding analysis can be conducted through Excel Add-In. The Morningstar®
Excel Add-In allows users to retrieve data points from the Morningstar databases
within Microsoft® Excel® for further calculation, formatting, or charting. Think of it as
an alternative to exporting data from Morningstar Direct. Download this Excel file, then
do the following:

1.

10.

1.

In the Excel file provided, select the Morningstar tab.

Click the Profile icon, then select Direct.

Enter your credentials then click Login.

Copy cell B2.

Select cell A3, where the data will display.

From the Morningstar toolbar, click Investments.

Click Investments.

Exercise 9: Leverage the
MSHOLDING Formula in
Excel Add-In

File Home |

sert  Page Layout

Investments

Profile

Fconomic Key

Data Indicators v

[Connection

A3 -

0 Not set

A

Functions

Jx

B

1 |PMC Diversified Equity Fund

PMDEX

3

5

Formulas Data

Review

Developer  Help

J | 5 |

Cell Sheet Workbook Schedule | Templates Hélp

Refresh

Resources

Morningstar

Acrobat

Pll Secure Tag

J

Under the Securities heading, select Holdings.

From the Position ID drop-down field, select Ticker.

In the Security field, paste the ticker, then select the security when it appears.

Note the highlighted areas.

i Morningstar Add-In

Holdings

' NAS:PMDEX
T

PMC Diversified Equity

Securities o Layout Output

Attributes/Time series O Row ® Column ¥ Show Headers

Holdings |

B Security Position ID

Identifiers PDEN e
Portfolio Management O i & ‘
Attributes/Time series FO NAS USA I @

oT

The option for Celumn should be selected, and the check box for Show Headers should

also be selected.

From the Start Date drop-down field, select Enter Dash Codes.

MORNINGSTAR
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https://advisor.morningstar.com/awsoe/training/2021workshops/Notebooks_AugustWkshp.xlsx

Discovering Stock Ownership Popularity Details

Exercise 9: Leverage the MSHOLDING Formula in Excel Add-In

12.
13.
14.
15.
16.

Enter ed-1y.

Enter Imend.

From the End Date drop-down field, select Enter Dash Codes.

From the Data type section, the option for Weight (%) should be selected.
Leave all other settings as is and click Add, then click Submit.

Note the values selected for
the Holdings set up window.

\'ﬂ Morningstar Add-In - O
Seauiics o Layout QOutput
SIS EEEs O Row @ Column Wl Show Headers
Holdings
Ownershi
RESLER Security Position ID
(e [PMC Diversified Equity | [Ticker -] Add
Portfolic Management || start Date End Date
Attributes/Time series [Enter Dash Cades B [ea-1y | @ [enter Dash coges B [imeng | @
Holdings Sort
M Descend @) Ascend (¥ Show holding name [ Show detail holding type [7) Show Country [ Show Coupon %
Holding type Data type
MDstocks  DBonds (O Funds O Errs @ Al ¥ Weight(%) [7) Market Value (7] Number of shares
Frequency Top N holding
[ -1l ] [7) Show Currency [7) Show Maturity Date

=

=MSHOLDING("NAS:PMDEX","TICKER","ed-1y","Imend”,"CORR=C, ASCENDING=TRUE, HT=ALL, FREQ...
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Discovering Stock Ownership Popularity Details

Exercise 9: Leverage the MSHOLDING Formula in Excel Add-In

17. Click Ctrl + F then search for the same stock being analyzed in the notebook.

A B (& D

EQR  Equity Residentii 0.12 012 0.13
AMGN Amgen Inc 0.31 0.21 0.13
C5 Credit Suisse Grc 0.16 0.17 0.13
ALXN Alexion Pharmac 0.11 0.13 0.13
NEE NextEra Energy li 0.15 0.15 0.12|
PKG Packaging Corp o 0.13 0.12 0.12|
NFLX Netflix Inc 0.20 0.19 0.12|
VST Vistra Corp 0.14 0.13 0.12|
WMB Williams Companies Inc 0.02 0.12|
NOW ServiceNow Inc 0.12 0.17 0.11
CHTR Charter Commun 0.36 0.23 0.10]
HCMLY LafargeHolcim Lt 0.15 0.15 0.10)
CLX Clorox Co 0.01 0.10 0.09
EQNR Equinor ASA ADE 0.06 0.06 0.05
AEG Aegon NV ADR 0.05
RMD ResMed Inc 0.07 0.09 0.0  |otethestock's
MQBKY Macquarie Groug 0.07 0.08 0.0  Previous position.
TWLO Twilio Inc A 0.05 0.05 0.08|
EDPFY EDP - Energias de 0.00 0.00 0.08|
IBEM International Bu: 0.08 0.08 0.08|
HSNGY Hang Seng Bank | 0.07 0.07 0.08|
ESS Essex Property Ti 0.04 0.05 0.08|
PXD Pioneer Natural | 0.11 0.13 0.07|
TTD The Trade Desk li 0.07 0.06 0.07|
IFNNY Infineon Technol 0.06 0.07 0.07|
SXYAY Sika AG ADR 0.07 0.06|
DIs The Walt Disney Co 0.06
RSNAY RSA Insurance Group PLC ADR 0.03 0.06]
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Exercise 10: Leverage the Stock Ownership Notebook with

Discovering Stock Ownership Popularity Details multiple stocks
To view the stock ownership for multiple stocks, do the following: Exercise 10: Leverage the
1. In the Select Stock(s) of Interest search field, type L. Stock Owne!'shlp
_ _ _ Notebook with
2. Click Lowes Corp listed on the New York Stock Exchange to select it. multiple stocks
3. From the Stock ownership table, click the menu in the bottom-right corner then
select 50.
< Note: The Stock Ownership table displays the funds that own Aegon NV and if they also own
Loews Corp. The funds that own only Loews Corp are displayed last.
Stock Ownership
Fund Name Portfolio Date Aegon NV Loews Corp
Dodge & Cox Stock Fund 2021-06-30 0.357 0
Dodge & Cox Balanced Fund 2021-06-30 0.22 0
PMC Diversified Equity Fund 2021-03-31 0.088 0
Avantis® International Equity ETF 2021-08-11 0.088 0
Avantis® International Equity Fund 2021-06-30 0.058 0
DFA World ex US Targeted Val Portfolio 2021-05-31 0.053 0
DFA Tax-Managed International Value Port 2021-06-30 0.047 0
DFA International Sustainahility 1 Portf 2021-06-30 0.036 0
DFA Large Cap International Portfolio 2021-06-30 0.029 0
DFA TA World ex US Core Equity Part 2021-06-30 0.021 0
Page 1 v of22 > Viewing 110 10 of 220 Show| 10 v
— ‘ T Select 50 to
5 view more funds.
E

4. From the Recent Buys and Sells drop-down, select Loews Corp.

5. Answer the following questions:

How many managers recently bought positions?

How many managers recently sold positions?
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